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1. PURPOSE 
 
Based on customer feedback, we have created this document to help our customers perform 
the most common tasks in the CerTest computer-based testing program.  As you become 
comfortable using CerTest and begin performing more advanced functions, you can obtain help 
performing these functions by using the Help pull-down menu in CerTest to access information 
or instructions on the topic you need help with.   
 
Before printing this document view it using the Print Preview function to ensure that the pages 
correspond with the Table of Contents. 
 
2. CERTEST OVERVIEW 
 
CerTest is an interactive computer-based certification and testing program designed to test and 
certify a student's knowledge of various job-related subjects.  CerTest has been in use since 
1989 and transitioned to the Windows environment in the fall of 1995. CerTest has been used 
by thousands of personnel worldwide. 
 
While CerTest is distributed with a number of tests already in the system, it is a program that is 
much more powerful than a standard test display mechanism.  Tests within CerTest use a 
variety of question types, including true/false, multiple choice, fill-in-the-blank, matching, 
sequencing, multiple/multiple choice, and graphic identification.  In addition, scenarios can be 
used with any question type so that students can be tested on application-type knowledge.  Any 
training materials, such as videotapes, print-based materials, and multimedia programs can be 
used with the CerTest system.   
 
CerTest has two primary parts; the student section and the management section.  In the student 
section, students can take tests and manage their training schedule by keeping track of their 
student record.   
 
Using CerTest, you can perform a number of management functions.  Most of these functions 
are available by accessing one of four lists available from the File menu; the Student List, 
Manager List, Test List, and Graphics Library. 
 
Using the Student List, you can add and delete students to CerTest and keep track of your 
student's records and progress.  In addition, managers must “unlock” each test for the students.  
Within the Student List, you may view lists of students within the system, or may focus on one 
student's record.  This record contains the student's status for each test as well as lock/unlock 
information and historical data about specific tests. 
 
There may be a number of managers in the CerTest system at any one time, and different 
managers may have different privileges.  You can refer to the Manager List to see what 
privileges are available to you or to add another manager with comparable privileges.  However, 
do not add a manager to CerTest unless you have been authorized to do so. The program will 
allow only three managers have test locking/unlocking privileges at any one time. 
The Test List is the most powerful feature of CerTest.  It is this feature that turns CerTest for 
Windows from a test display mechanism to a training development tool.  The test list is the area 
of CerTest where you, as a manager, can create your own tests and track data about tests 
already in the system. 
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When developing tests, you can create questions using any of the seven question types and 
can build scenarios into any question.  You can also set the criterion level, provide section 
information, add notes about the test for the student, and set the size of the question pools. 
 
In addition, graphics may be used to support any question type.  Thus, when developing a test, 
go to the Graphics Library to pull graphics into your questions.  CerTest is distributed with 
hundreds of graphics.  When developing a test, you may use the graphics already in the 
Graphics Library, or you can import select graphics into the library from other graphics 
packages.  
 
In addition to the four available lists, there are other features in CerTest for Windows such as 
the ability to customize and print a variety of reports, statistical data collection, the ability to 
upload and download student records and tests, and back-up and restore features. 
 
Security is an important part of the CerTest system.  Thus, there are a number of "security 
features" built into CerTest.  First, for both students and managers, entry into CerTest is 
password protected, and passwords are encrypted.  Also, all tests in the system are "locked" 
and managers must unlock each test before a student has access.  Most tests will automatically 
lock once it has been passed once or failed twice.  Access to that test is then only available to a 
student if a manager unlocks the test again.   
 
Another security feature is the three-randomization techniques used in CerTest.  First, test 
questions are pulled from a pool of questions.  Secondly, once the questions have been 
determined, they appear in a random order.  Finally, for multiple choice, multiple/multiple choice, 
matching, and sequencing questions, the responses are displayed in a random order.  
Additionally, all CerTest student, manager, and test data is encrypted. 
 
All tests distributed within CerTest have gone through an extensive test development process 
that included reviews by both test development experts and subject matter experts.  However, if 
a student wishes to challenge a test question, he/she may challenge the question by clicking the 
hand icon on the toolbar, or by selecting “Challenge This Question” from the Help menu.  This 
allows the student to type a short description of the error.  You may view, print, or download 
some or all of these Question Challenges.  See the “Challenging Questions” section of this 
guide for more details. 
 
3. HOW TO START CerTest 
 

1.  From the Program Manager, double-click on the CerTest icon. 
 
2.  Click on the CerTest title screen to get to the log-on screen. 
 

 3. Enter the following Social Security Number and password. 
 
If you are installing CerTest on a computer for the first time, your system comes pre-loaded with 
the manager Sir Test.  To log-on as “Sir Test”, type: 
 
Social Security Number: 123-45-6789 
Password:  CE 
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 4. Site Information:  After you log-on to CerTest the first time, you will be asked to enter 
your Site Name.  The Site Name consists of your base name followed by a computer 
designation/location.  This will only need to be done once per computer. 

  
 Example:  Tyndall AFB FL 
                          Computer #1 
 
**Once you have added yourself as a manager (with all privileges); log on once again 
using your log on information.  Then delete “Sir Test”.  Until you have deleted “Sir Test” 
your CerTest is NOT secure and subject to compromise!!  

 
4. HOW TO OPEN STUDENT LIST 
 
To open the student list: 
 
 1. Select File (menu bar). 

2. Select Open Student List. 
 
Use the Specialty drop-down list box to limit the student list to only students in a specific 
specialty. 
 
Shortcut keys: 
 
CTRL + S will also open the student list. 
 
5. HOW TO ADD A STUDENT 
 

1.  Open Student List. 
 
2.  Select Edit (menu bar). 
 
3.  Select Add Student. 
 
4. On the New Student Information screen: 

Input: 
 
a) Student's Last Name 
b) Student's First Name 
c) Student's Social Security Number (SSN) 
d) Rank and Middle Initial are optional. 
 
Select: 
 
a) Specialty by double clicking on the student's career-related AFSC 
 

5.  Select Password. 
 
6. In the Change Student's Password dialogue box: 

 
a) Input the New Password.  
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b) Verify the password by inputting what was typed in the New Password text box.  
c) Select OK.  
 

7. Select OK on the Student Information screen.  
 
 A system message displays informing you that the student you enrolled has been 
added.  
 

8. Select OK in the system message box.  
 
Shortcut keys:   
 
Pressing the SHIFT + INSERT keys or clicking on the "+" icon in the tool bar will replace steps 2 
and 3. 
 
Additional information:   
 
A student may enroll in more than one Specialty at a time.  This is not the norm but if you find a 
need for this capability, it is available to you by just double-clicking on a second Specialty. 
 
6. HOW TO DELETE A STUDENT 
 

1.  Open Student List. 
 
2.  Highlight the student's name for deletion. 
 
3.  Select Edit (menu bar). 
 
4.  Select Delete Student. 
 
5. Select Yes in the Delete Student(s) confirmation box. 

 
Warning:  Deleting a student removes ALL the student's records (test scores and history) from 
the CerTest System. 
 
Shortcut keys: 
 
SHIFT + DELETE will replace steps 3 and 4. 
 
Additional Information:   
 
You may select multiple students for deletion. 
 
7. HOW TO EDIT STUDENT INFORMATION 
 

1.  Open Student List. 
 
2.  Highlight the name of the student whose information you want to update or change. 
3.  Select View (menu bar). 
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4.  Select Student Info. 
 
5. The Student Information screen displays.  You can edit/change the student's 

information and/or password on this screen. 
 
Shortcut: 
 
Clicking on the "i" icon will replace steps 3 and 4. 
 
8. HOW TO LOCK AND UN-LOCK TESTS 
 
Locking and unlocking a test allows the manager to open a test for a student to take or close a 
test to prevent a student from taking or viewing it.  If a test is locked, a key is displayed to the 
left of that test's name on the Student Record screen. 
 

1.  Open Student List. 
 
2.  Highlight the name of the student whose record you want to view. 
 
3.  Select View (menu bar). 
 
4.  Select Student Record. 
 
5.  Highlight the desired test for locking or unlocking on the Student Record screen. 
 
6. Click on the key icon directly below the menu bar. 

 
Helpful Hints: 
 
You can double-click on the lock column next to a test to toggle the lock status.  
 
You can use the L and U keys to Lock or Unlock tests instead of the key icon in the tool bar. 
 
Note:  Only three (3) CerTest managers have the Lock/Unlock Tests privilege at a time.  
 
For test security purposes, each student may have only one (1) Hazardous Materials test (tests 
8501 through 8512) unlocked at a time. 
 
For test security purposes, when a student exits CerTest, any unlocked Hazardous Materials 
test will be locked for that student.  A manager will have to unlock the test before the student 
may take the test. 
 
Additional Information:   
 
You can lock and unlock more than one test by: 

 
1. Pressing the CTRL key while clicking on a test will make an additional selection 

without deleting any previous selection(s). 
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2. Pressing the SHIFT key while clicking on another test will select that test and all the 
tests between an earlier selection and your current selection. 

 
To lock/unlock a test for multiple students at once: 
 

1.  Open Test List. 
 
2.  Highlight the test you want to lock/unlock. 
 
3.  Click on the key icon directly below the menu bar. 
 
4.  Highlight the students for whom you wish to lock/unlock the test. 
 
5. Click the Unlock button to unlock the test for the highlighted students, or click the Lock 

button to lock the test. 
 
To exit the Student Record screen: 
Press CTRL + S. 
 
9. HOW TO BOOKMARK A QUESTION 
 
When taking a test, a student may choose to mark a question and return to it later before the 
test is exited and scored. 
 
To bookmark a question: 
 

1.  Click on the Bookmark check box (lower left hand corner of the computer screen). 
 
2.  Name the bookmark or accept the name provided. 
 
3.  Select OK. 
 

 4. Select Next to move forward in the test or the back arrow to move backward in the 
test. 

 
To return to a bookmarked question: 
 

1.  Select Bookmark (menu bar). 
 

 2. Select the desired bookmark. 
 
To release a desired bookmarked question: 
 

1.  Click on the Bookmark check box (lower left screen). 
 
Additional Information:   
When you choose to Exit and Score a test, a system message appears if you have any 
bookmarked questions.  This message asks you if you want to exit with questions still 
bookmarked. 
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10. HOW TO MOVE WITHIN A TEST  
 
To move forward one question at a time within a test: 
 
 1. Select Next (located in the top left-hand corner of computer screen) 
 
  or… 
 

2.  Press Enter or Select the View (menu bar) 
 

 3. Then Select Next Question or CTRL + N 
  or… 
 
 4. Click on the arrow button located on the horizontal scrolling bar in the lower right-hand 

corner of the test screen 
 
To move forward one or more questions at a time: 
 
 1. Drag the horizontal scrolling bar to the right. 
 
To move backwards one question at a time within a test: 
 
 1. Select the left arrow icon in the tool bar (located left of Next button) 
 
  or… 
 

2.  Select the View (menu bar) and Select Previous Question or Press the CTRL + P keys 
 

or... 
 
 3. Click on the left arrow located on the horizontal scrolling bar in the lower right-hand 

corner of the test screen. 
 
To move backward one or more questions at a time: 
 

1.  Select the Bookmark (menu bar). 
 

 2. Select Last Viewed Question 
 
  or... 
 

3.  Drag the horizontal bar in the lower right-hand corner of the test screen to the left. 
 
 
11. HOW TO VIEW A DETAIL TEST RECORD 
 
The details of a student's individual tests are found on the Test Summary screen. 
 
To display the details of a student’s test: 
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1.  Open Student List. 
 
2.  Highlight the student whose tests' results you want to view. 
 
3.  Select View (menu bar). 
4.  Select Student Record. 
 
5.  Highlight test on Student Record you want to view. 
 
6.  Select View (menu bar). 
 
7. Select Detail. 

 
 Test Summary screen appears. 
 

8.  Select Cancel to exit when you are finished viewing. 
 
12. HOW TO VIEW A TEST SUMMARY 
 
The Test Summary screen is used to view the detail of one of the tests an individual student 
took.  It indicates how a student scored on the test. 
 
The Test Summary contains: 
 

• The student's score 
• The passing score for the test 
• Whether or not the student passed the test 
• Number of questions presented and correct for each section of the test 

 
Student Record 
 
The Student Record screen displays the student's CerTest profile. 
 
To view a Student's Record: 

1.  Open Student List. 
 
2.  Highlight the name of the student whose record you want to view. 
 
3.  Select View (menu bar). 
 
4.  Select Student Record. 
 
5.  Student Record screen displays.  This screen displays the student's test profile.  This 

profile includes: 
 

a) Student's Specialty 
b) What tests the student is authorized to take 
c) Each test's statistics 
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d) The student's test score, the test score's date, and the number of times the student took 
the test 

To exit the Student's Record: 
 
Press CTRL + S. 
 
Helpful Hints: 
 

• Double clicking on a student replaces steps 2 through 4. 
• Pressing the Enter key replaces steps 3 and 4. 

 
13. HOW TO VIEW STUDENT RECORDS 
 
The Student Record screen displays the student's CerTest profile.  
 

1. Open Student List. 
 
2. Highlight the name of the student whose record you want to view. 
 
3. Select View (menu bar). 
 
4. Select Student Record. 
 
5. Student Record screen displays.  This screen displays the student's test profile.  This 

profile includes: 
 
a) Student's Specialty 
b) What tests the student is authorized to take 
c) Each test's statistics 
d) The student's test score, the test score's date and the number of times the student took 

the test 
 
To exit the Student's Record:  
 
Press CTRL + S.  
 
Helpful Hints: 
 

• Double clicking on a student replaces steps 2 through 4. 
• Pressing the Enter key replaces steps 3 and 4. 
 

 
14. HOW TO PRINT A STUDENT RECORD 
 
The Print function allows you to print a hard copy of a Student Record. 
 
To print a student record: 

 
1.  Open Student List. 
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2.  Double-click on the student whose record you want to view/print.  Student Record 

screen displays. 
 
3.  Select File (menu bar). 
 
4.  Select Print. 
 
 Report Format box displays. 
 
5. Click on the Display Social Security Number check box if you do not want the student's 

Social Security Number to appear on the printout. 
 

6. Select Print Full Record, Organized by Training Area to print all the posttests in the 
student's record, organized by Training Area.  Any Filter/Sort options will be ignored 
when printing using this option. 

 
 or... 

 
Select Print Record as Currently Displayed to print only those tests that are 
displayed as a result of the current Filter/Sort options.  This print will also be limited to 
only the selected Training Area (if not All Training Areas). 

 
7. The Print Preview screen displays. 

 
 Select the printer icon from the tool bar at the top of the screen. 
 
8. Select Print Range. (The default is all pages.) 
 
9.  Input number of copies. (The default is 1.) 
 
10. Select OK.  The Student Record screen displays: 

 
Shortcut:  
 
Click on printer icon in tool bar to replace steps 3 and 4. 
 
15. HOW TO COPY A STUDENT’S RECORD TO A DISKETTE 
 
You may want to back up one or more students' record(s) from the CerTest system to a 
diskette. This backup copy can be used to reinstall a student record(s) that was deleted from 
the CerTest system, to copy a student record from one computer system to another, or to 
replace a student record that has become corrupted.  If a student record becomes corrupted, 
the student should be deleted before you copy student from diskette.  

1.  Open Student List 
 
2.  Highlight the student(s) to copy. 
 
3.  Select Copy to Diskette (File pull-down menu). 
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4.  Select Yes in the Copy Student(s) box. 
 
5. In the Copy Student(s) To box: 

 
Select: 
 

• The drive containing the target diskette 
• The Directory 

 
Input: 
 

• The file name in the File Name test box 
 

6.  Select OK. 
 
7. Select OK in the Copy Complete information box. 

 
Shortcut Key: Pressing the F8 key or clicking on the disk icon in the tool bar replaces step 3 
above. 
 
Helpful hint:  You may copy more than one student record at a time by selecting multiple 
records.  To select a block of student records, highlight the first student in the block then press 
and hold the SHIFT key while clicking on the last student in the block.  To select multiple 
student records that are not in sequence, press and hold the CTRL key while clicking on each 
record you want to copy. 
 
Additional information:  Student files have an .std extension.  When you copy students to a 
diskette, a text file is also created on the diskette.  This text file has the same name as the 
student file, but has a .txt extension.  The text file contains a list of all students copied into the 
student (.std) file and may be viewed using Windows® Notepad. 
 
16. HOW TO COPY A STUDENT’S RECORD FROM A DISKETTE 
 
You may want to copy a student record from a diskette in order to reinstall a student who has 
been deleted from the CerTest system or to move a student from one computer system to 
another.  If a student record is corrupted, the student should be deleted before the record is 
copied to the system from a diskette.   
 
If you copy a student from a diskette and the student already exists in the system, you will be 
given the option to merge the record on the diskette with the record on the system.  The new 
student record on the system will contain a history of when each test was taken, but will contain 
a summary of only the most recent time each test was taken. 
 
To Copy a Student from Diskette: 
 

1.  Select Copy From Diskette (File pull-down menu). 
 
2. On the Copy From screen: 
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Select: 
 

• Student from the List Files of Type drop-down list box 
• The drive containing the source diskette 
• The source file name 

 
3.  Select OK. 
 
4.  If more than one student record was copied into the selected file, you must select the 

student record(s) you want to copy in the Copy Students Into CerTest list box.  Select 
copy. 

 
5. Select OK in the Copy Complete information box. 

 
Helpful Hint: 
 

• If you start this process with Open Student List, CerTest will automatically select 
Student in the List Files of Type field, allowing you to skip this entry in Step 2 above. 

 
17. HOW TO PRINT THE STUDENT LIST 
 
The Print function allows you to print a hard copy of the Student List. 
 

1.  Open Student List 
 
2.  Select File (menu bar). 
 
3. Select Print. 

 
 Report Format box displays. 
 
The format options available are: 
 

• Organize students by Specialty 
• Display Rank 
• Display Social Security Number 

 
You can choose one or all of these options to format your printout by clicking on the desired 
check box(es).  The default is Display Rank so you will have to deselect it if you do not want this 
option. 
 

4. Select or deselect the format options.  Then select OK. 
 
 Print Preview screen displays. 
 
5.  Select printer icon in tool bar. 
 
6.  Select Print Range.  (The default is all pages.) 
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7.  Input number of copies. (The default is 1.) 
 
8. Select OK. 

 
The Student List screen displays: 

 
Shortcut:  
 
Click on printer icon in tool bar to replace steps 2 and 3. 
 
18. HOW TO OPEN THE MANAGER LIST 
 
Open Manager List displays all the managers who have access to CerTest. 
 

1.  Select File (menu bar). 
 
2. Select Open Manager List. 

 
Shortcut keys: 
 
CTRL + M will also open the manager list. 
 
19. HOW TO ADD A MANAGER 
 
Add Manager registers an individual as a manager in the CerTest system.  
 

1.  Open Manager List. 
 
2.  Select Edit (menu bar). 
3.  Select Add Manager. 
 
4.  On the New Manager Information screen: 

 
a) Input: 
 

• Manager's Last Name 
• Manager's First Name 
• Manager's Social Security Number (SSN)  
• Rank and Middle Initial are optional fields.  

 
b) Deselect, if necessary, any Specialty you do NOT want this manager to be able to work 

within by double clicking on the career-related AFSC 
 

5.  Select Password. 
 
6. In the Change Manager's Password dialogue box: 
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       a) Input New Password.  
     b) Verify Password by inputting what was typed in the New Password text box.  
       c) Select OK.  
 

7. Select Privileges 
 
Within the CerTest system, a manager can have three types of privileges.  These are Test, File, 
and Personnel privileges.  The Privileges screen displays these privilege types and subdivides 
the responsibilities within each type into check box options.  
 
Note:  A maximum of three (3) managers may be given the Personnel privilege to Lock/Unlock 
Tests.  If your CerTest system has three managers with the Lock/Unlock Tests privilege, you 
must remove this privilege from one of these managers before you may give it to another 
manager. 
 
 8. To change the default selections for a privilege on this screen:  
 
 Click on the desired option's check box.  
 

9.  When the screen reflects the desired privileges for this manager, select OK.  
 
10. Select OK on the New Manager Information screen.  

 
 A system message displays informing you that the new manager you enrolled has 

been added.  
 

11. Select OK in the system message box.  
 
Shortcut keys: 
 
SHIFT + INSERT will replace steps 2 and 3. 
 
Note:  You cannot give a new manager privileges that you do not have. 
 
20. HOW TO DELETE A MANAGER 
 
Delete Manager removes a manager from the CerTest system.  
 

1.  Open Manager List. 
 
2.  Highlight the manager's name for deletion. 
 
3.  Select Edit (menu bar). 
 
4.  Select Delete Manager. 
 
5. Select Yes in the Delete Manager(s) confirmation box. 

 
Shortcut keys: 
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SHIFT + DELETE will replace steps 3 and 4. 
 
Note:  You may not edit or delete a manager that has privileges that you do not have. 
 
21. HOW TO EDIT A MANAGER’S INFORMATION 
 
Edit Manager Information allows a CerTest manager to update and/or change another CerTest 
manager's information.  
 

1.  Open Manager List. 
 
2.  Highlight the name of the manager whose information you want to update or change. 
 
3.  Select View (menu bar). 
 
4.  Select Manager Info. 
 
5.  The Manager Information screen displays.  You can edit/change a manager's 

information and/or password on this screen. 
 
6. To change the manager's privileges, select Privileges 

Within the CerTest system, a manager can have three types of privileges.  These are 
Test, File, and Personnel privileges.  The Privileges screen displays these privilege 
types and subdivides the responsibilities within each type into check box options.  

 
Note:  A maximum of three (3) managers may be given the Personnel privilege to 
Lock/Unlock Tests.  If your CerTest system has three managers with the Lock/Unlock 
Tests privilege, you must remove this privilege from one of these managers before you 
may give it to another manager. 

 
7. To change a privilege on this screen:  

 
 Click on the desired option's check box.  
 

8.  When the screen reflects the desired privileges for this manager, select OK.  
 
9. Select OK from the Manager Information screen to save the changes. 

 
Shortcut keys: 
 
Clicking on the "i" icon in the tool bar can be used in place of steps 3 and 4. 
 
22. HOW TO PRINT THE MANAGER LIST 
 
The Print function allows you to print a hard copy of the Manager List. 
 
To print the manager list: 
 

1.  Open Manager List. 
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2.  Select File (menu bar). 
 
3. Select Print. 

 
 Print Preview screen displays. 
 

4.  Select printer icon in tool bar. 
 
5.  Select Print Range.  (The default is all pages.) 
 
6.  Input number of copies. (The default is 1.) 
 
7. Select OK. 

 
The Manager List screen displays. 
 
Shortcut:   
 
Click on printer icon in tool bar to replace steps 2 and 3. 
 
23. HOW TO OPEN THE TEST LIST 
 
Open Test List displays all the tests currently available within the CerTest system. 
 

1.  Select File (menu bar). 
 
2. Select Open Test List. 

 
All the tests available within the CerTest system are available for viewing in the Tests box when 
you first open the test list.  Use the Specialty and Training Area drop-down list boxes to limit the 
test list to only tests in a specific Specialty and/or Training Area. 
 
Shortcut keys: 
 
CTRL + T will also open the test list. 
 
 
24. HOW TO ADD A TEST 
 
Add Test creates a test and adds that test to the CerTest system.  Test questions are then 
created using Edit Test. 
 

1.  Open Test List. 
 
2.  Select Edit (menu bar). 
 
3.  Select Add Test. 
 
4. On the Test Information screen: 
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Input: 
 

• Test Number (Test numbers 100 through 999 and 8000 through 9999 are reserved for 
DoD Wide tests.) 

 
• Test Name 
 
• Passing Criterion (This determines what score the student must get in order to pass 

the test.)  
 
Select:  
 

• Specialty/Training Area 
• Statistical Data Type 

 
5. Select OK. 

 
Note:  A test must be in at least one Specialty/Training Area. 
 
Shortcut keys: 
 
Pressing SHIFT + INS or holding down the SHIFT key while clicking on the plus icon on the tool 
bar can be used in place of steps 2 and 3. 
 
25. HOW TO DELETE A TEST 
 
Delete Test erases a test from the CerTest system.  Before a test can be deleted, all the 
questions for that test must be deleted using Remove Question.   
 
Warning:  Once a test is deleted, you will not be able to undo the deletion.  You will have to 
recreate the test.  Also, any students who have taken the test will lose their score/detail 
record/history for the test. 
 

1.  Open Test List. 
 
2.  Highlight the desired test. 
 
3.  Select Edit (menu bar). 
 
4.  Select Delete Test. 
 
5. Select Yes. 

 
Shortcut keys: 
 
Pressing SHIFT + DEL or holding down the SHIFT key while clicking on the scissors icon in the 
tool bar can be used in place of steps 3 and 4. 
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26. HOW TO ENABLE SECURE TESTS 
 
Some tests within CerTest are Certification tests and will not be available without permission 
from the Air Force Project coordinator listed in your CerTest Procedural Guide.  These tests are: 
 
EPA CFC Tests: 
 
 8000 CFC Core Test 
 8001 CFC Type I Test 
 8002 CFC Type II Test 
 8003 CFC Type III Test 
 
Hazardous Materials Tests: 
 
 8501 (CDC 47201) Awareness (Test A) 
 8502 (CDC 47201) Awareness (Test B) 
 8503 (CDC 47202) Operations - Part 1 (Test A) 
 8504 (CDC 47202) Operations - Part 2 (Test A) 
 8505 (CDC 47202) Operations - Part 1 (Test B) 
 8506 (CDC 47202) Operations - Part 2 (Test B) 
 8507 (CDC 47203) Technician - Part 1 (Test A) 
 8508 (CDC 47203) Technician - Part 2 (Test A) 
 8509 (CDC 47203) Technician - Part 1 (Test B) 
 8510 (CDC 47203) Technician - Part 2 (Test B) 
 8511 (CDC 47205) Incident Commander (Test A) 
 8512 (CDC 47205) Incident Commander (Test B) 
 
To enable either group of tests, you must call the point of contact (POC) listed in the Procedural 
Guide, give them your eight digit Site Code, and get the corresponding eight digit Enable Code. 
 
To Enable Secure Tests: 
 

1.  Select Enable Secure Tests from the File menu. 
 
2. Highlight the Test Group you wish to enable. 
 
3. Contact the POC identified in the Contact Information box, and give them your eight 

digit Site Code.  The POC will then give you a corresponding eight digit Enable Code.   
  
Note:  Your Site Code may be different for each Test Group.  Be sure the correct Test Group is 
highlighted when you refer to the Site Code. 
 

3.  Enter the eight digit Enable Code and select OK. 
 

Note:  The POC may not be available when you call.  Leave your Site Code and the POC will 
call you back.  When you receive the Enable Code, select Enable Secure Tests again and enter 
the Enable Code. 
 
27. HOW TO PRINT THE TEST LIST 
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The Print function allows you to print a hard copy of the Test List.  
 

1.  Open Test List. 
 
2.  Select File (menu bar). 
 
3. Select Print. 

 
 Report Format box displays. 
 

4.  Click on the Organize Tests by Location check box if you want the printout to include 
all the Specialties/Training Areas each test is assigned to. 

 
5. Click on OK. 
 

 Print Preview screen displays. 
 

6.  Select printer icon in tool bar. 
 
7.  Select Print Range.  (The default is all pages.) 
 
8.  Input number of copies. (The default is 1.) 
 
9. Select OK. 

 
The Test List screen displays: 

 
Shortcut:   
 
Click on printer icon in tool bar to replace steps 2 and 3. 
 
 
 
 
28. HOW TO COPY A TEST TO DISKETTE 
You may want to back up individual tests from the CerTest system to a diskette.  This backup 
copy can be used to reinstall a test that was deleted from the CerTest system, to copy a test 
from one computer system to another, or to replace a test that has become corrupted. 
 

1.  Open Test List. 
 
2.  Highlight the desired test(s). 
 
3.  Select Copy To Diskette (File pull-down menu). 
 
4.  Select Yes in the Copy Test(s) box. 
 
5. On the Copy To screen: 
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Select: 
 

• The drive containing the target diskette 
• The Directory 

 
Input: 
 

• The target file name 
 

6. Select OK. 
 

7. Select OK in the Copy Complete information box. 
 
Shortcut Key: 
 
Pressing the F8 key or clicking on the disk icon in the tool bar replaces step 3 above. 
 
Helpful Hint:  You may copy more than one test at a time by selecting multiple tests.  To select a 
block of tests, highlight the first test in the block then press and hold the SHIFT key while 
clicking on the last test in the block.  To select multiple test records that are not in sequence, 
press and hold the CTRL key while clicking on each test you want to copy. 
 
Additional information:  Test files have an extension of .tst.  When you copy tests to a diskette, a 
text file is also created on the diskette.  This text file has the same name as the test file, but has 
a .txt extension.  The text file contains a list of all tests copied into the test (.tst) file and may be 
viewed using Windows® Notepad. 
 
29. HOW TO COPY A TEST FROM DISKETTE 
 
You may want to copy a test from a diskette in order to reinstall a test that has been deleted 
from the CerTest system, to copy a test from one computer system to another, or to replace a 
test that has become corrupted. 
 

1.  Select Copy From Diskette (File pull-down menu). 
 
2. On the Copy From screen: 

 
Select: 
 

• Test from the List Files of Type drop-down list box. 
• The drive containing the source diskette from the Drives drop-down list box 
• The Directory 
• The source file name from the File Name list 

 
3.  Select OK. 
 
4.  If more than one test record was copied into the selected file, you must select the test 

record(s) you want to copy in the Copy Tests into CerTest list box.  Select Copy. 
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5. Select OK in the Copy Complete information box. 

 
Helpful Hint: 
 

• If you start this process with Open Test List, CerTest will automatically select Test in 
the List Files of Type field, allowing you to skip this entry in step 2 above. 

 
30. HOW TO ASSIGN A TEST TO A SPECIALTY OR TRAINING AREA 
 
Specialties are career-related AFSCs.  Training Areas are subdivisions of Specialties.  Tests 
must be assigned to one or more Specialties.  Within each Specialty the test must be assigned 
a Training Area.  The Training Area determines where in the Specialty the test will appear for a 
student. 
 
A Training Area Pretest is composed of designated questions from all the sections in all the 
tests assigned to a Training Area. 
 

1.  Double-click on the desired Specialty in the Specialty/Training Area Location list box 
on the Test Information screen. 

 
2.  Highlight the desired Training Area within the Training Area list box. 
 
3.  Select OK. 
 

Observation: 
 
A blue check mark displays next to the Specialty.  The Training Area is displayed below the 
Specialty with a blue connecting line. 
 
Note:  Pretests for Training Areas will automatically be updated to include the Pretest 
designated questions from the tests assigned to the Training Areas. 
 
31. HOW TO MOVE A TEST TO ANOTHER TRAINING AREA 
 
Moving a test to another Training Area within a Specialty does not affect student scores/detail 
records/history for that test. 
 

1.  Open Test List. 
 
2.  Highlight the desired test. 
3.  Select View (menu bar). 
 
4.  Select Test Info. 
 
5.  Double-click on the Training Area you wish to move the test from in the 

Specialty/Training Area Location box. 
 
 The Training Area List is displayed. 
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6. Select a new Training Area within the Specialty by: 

 
• Highlighting the new Training Area in the Training Area List. 
• Selecting OK. 

 
7.  Verify the change on the Test Information screen. 
 
8. Select the OK button on the Test Information screen. 

 
Helpful Hint: 
 
To find all the tests assigned to a specific Training Area, select the Training Area from the 
Training Area drop-down list box on the Test List screen.  (Be sure All Specialties are selected 
in the Specialty drop-down list box on the Test List screen.) 
 
 
32. HOW TO OPEN A TRAINING AREA LIST 
 
Open Training Area List displays all the available Training Areas in CerTest.  
 

1.  Select File (menu bar). 
 
2. Select Open Training Area List. 

 
Training Areas screen displays. 

 
33. HOW TO ADD A TRAINING AREA 
 
All tests are located in Training Areas and Specialties.  You can create Training Areas as a way 
to group the tests that you develop.  There is one generic Site Specific Training Area; however, 
you can customize the Training Area, or create additional site specific Training Areas. 
 
When you add a Training Area, it will be site specific unless you have DoD-wide test privileges. 
 

1.  Open Training Area List. 
2.  Select Edit (menu bar). 
 
3.  Select Add Training Area. 
 
 Training Area Information box displays. 

 
4.  Input a name for the new Training Area in the Training Area Name text box. 
 
5. Managers cannot add a DoD Wide Training Area unless they have the create/edit DoD 

Wide Tests privilege. 
 

If you have DoD Wide Tests privilege and you want to add a DoD Wide Training Area, 
you will need to deselect the Site Specific Training Area check box. 
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6. If you wish a pretest to be generated for the named Training Area: 

 
• Select Pretest Available by clicking on the check box. 
 
• Select Pretest Info button. 
 
• The default for the Pretest Name is the Training Area name with "Pretest" added.  

The default Pretest Name can be edited. 
 

7. Use the up and down arrows above and below the word "Move" and to the right of the 
box labeled Location in Training Area List to select where the new Training Area will 
appear in the Training Area List.   

 
Note:  Any Training Area above the dotted line is DoD Wide.  Any Training Area below 
the dotted line is Site Specific. 

 
8.  Select OK to add the Training Area at the indicated position to the Location in Training 

Area List. 
 

34. HOW TO DELETE A TRAINING AREA 
 
Delete Training Area removes the Training Area from the CerTest System.  Before a Training 
Area can be deleted, all the questions and any test(s) associated with that Training Area must 
be deleted/removed from the CerTest system or the tests in that Training Area must be moved 
to another Training Area.   
 
Warning:  Once a Training Area is deleted, you will not be able to undo the deletion.  You 
will have to add the Training Area again and recreate or reassign the test(s).  Also, any 
students who have taken the test will lose their score/detail record/history for the test if 
you delete the test or move the test from a student's specialty. 
 

1.  Before deleting a Training Area, you must first move all tests assigned to that Training 
Area into another Training Area, or Delete All Tests in that Training Area. 

 
2.  Open Training Area List. 
 
3.  Highlight the Training Area you wish to delete. 
 
4.  Select Edit (menu bar). 
 
5. Select Delete Training Area. 

 
If a Training Area contains tests when you try to delete it, a system message displays 
informing you that the Training Area may not be deleted until all tests are removed 
from it. 

 
35. HOW TO VIEW THE TRAINING AREA INFORMATION SCREEN 
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The Training Area Information screen is accessed through View in the menu bar.  On this 
screen you can change the selected Training Area's name, select/deselect Pretest Available, 
add/edit the Pretest Information if Pretest Available is selected, and/or move the selected 
Training Area to a new location in the Training Area list. 
 

1.  Open Training Area List. 
 
2.  Highlight the desired Training Area. 
 
3.  Select View (menu bar). 
 
4. Select Training Area Info. 

 
Training Area Information screen displays. 
 
Note:  Managers cannot view the Training Area Information on a DoD Wide Training 
Area unless they have the create/edit DoD Wide Tests privilege. 
 

5. On the Training Area Information screen, you can: 
 

• Edit the selected Training Area's name. 
 
• Select/deselect Pretest Available. 
 
• Move the selected Training Area to a new location in the Training Area list using 

the up and down arrows next to the Location box. 
 
The Training Area Information screen contains the following buttons: 
 

• Pretest Info, which allows you to add/edit the Pretest Information if Pretest Available is 
selected.  

• Help, which will display the available information on this screen.  
 
• Cancel, which returns you to the Training Area List without saving any changes made 

to the information on this screen.  
 
• OK which returns you to the Training Area List screen and saves the changes made to 

the information on the Training Area Information screen. 
 
36. HOW TO VIEW ALL RECORDS IN A SPECIALTY & PRINT A REPORT  
 
This is one of the report options in the Report pull-down menu.  If you make no changes to the 
Report Options screen, this menu option will print a report by specialty.  Under each Specialty, 
each student assigned to that specialty will be listed alphabetically.  Under each student's 
name, all the tests in the student's record will be listed and sorted by Training Area.  The lock 
status, title, test status (needed, passed, or failed), score, date last taken, and number of 
attempts will be indicated for each test. 
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To choose the All Records in a Specialty option and print the report: 
 

1.  Select Reports (menu bar). 
 
2.  Select All Records in a Specialty. 
 
 Report Options screen displays. 
 
3. Select Print Report. 

 
 Print Preview screen displays. 
 

4.  Select printer icon in tool bar. 
 
5. Select Print Range.  (The default is all pages.) 
 
6.  Input number of copies. (The default is 1.) 
 
7. Select OK. 

 
Important Note:  Depending upon the number of students you have enrolled, it may take 
several minutes (possibly hours) to generate the report before it displays on the Print Preview 
screen.  The more you filter and limit the report, the faster the report will be generated. 
 
37. HOW TO CHOOSE THE TESTS TAKEN IN THE LAST 30 DAYS & PRINT 
 
This is one of the report options in the Report pull-down menu.  If you make no changes to the 
Report Options screen that displays after you make this selection, a report by specialty for each 
student assigned to that specialty who has taken a test within the last 30 days will be generated.  
For each student, Training Area will sort the tests.  The lock status, title, test status (needed, 
passed, or failed), score, date last taken, and number of attempts will be indicated for each test. 

1.  Select Reports (menu bar). 
 
2. Select Tests - Last 30 Days. 

Report Options screen displays with the option all tests that have been taken between 
the dates (30 days before) and (present date) filled in and selected. 

 
3. Select Print Report. 
 
 Print Preview screen displays. 
 
4.  Select printer icon in tool bar. 
 
5.  Select Print Range.  (The default is all pages.) 
 
6.  Input number of copies. (The default is 1.) 
 
7. Select OK. 
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Important Note:  Depending upon the number of students you have enrolled, it may take 
several minutes to generate the report before it displays on the Print Preview screen.  
 
38. HOW TO CHOOSE THE SPECIALTY COMPLETION REPORT & PRINT 
 
This is one of the report options in the Report pull-down menu.  If you make no changes to the 
limited Report Options screen that displays after you make this selection, a report is generated 
listing all students alphabetically.  Beneath each student is listed the student's specialty and the 
percentage of tests within that specialty that the student has mastered.  Below each specialty is 
listed the percentage completion for each of the training areas within that specialty. 
 

1.  Select Reports (menu bar). 
 
2. Select Specialty Completion Report. 
 

A Report Options screen displays. 
 
To limit the report to only students who have completed more than a certain percentage of their 
specialty, enter the percentage in the appropriate blank. 
 
The default report covers All Specialties and All Training Areas.  You may select a specific 
specialty or training area to limit the report. 
 
The default report will print each student's completion percentage as of 30 days ago, as well as 
their current completion percentage.  To not print the percentage from 30 days ago, uncheck 
the "30 Day Progress Report" box. 
 
Note:  Un-checking the "30 Day Progress Report" box will speed up the generation of the 
report. 
To print the training area break down for each specialty, check the "Display percentage 
completion for Training Area(s)" box. 
If you do not want to have the Social Security Number of each student displayed, click the 
"Display Social Security Number" box. 
 

3. Select Print Report. 
 
 Print Preview screen displays. 
 
4.  Select printer icon in tool bar. 
 
5.  Select Print Range.  (The default is all pages.) 
 
6.  Input number of copies. (The default is 1.) 
 
7.  Select OK. 

 
Important Note:  Depending upon the number of students you have enrolled, it may take 
several minutes to generate the report before it displays on the Print Preview screen. 
 
39. HOW TO CHOOSE THE CUSTOM OPTION & PRINT REPORTS 
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This is one of the report options in the Report pull-down menu.  Use this report option if you 
want to generate a report covering more than one student.   For example, if you want a list of 
any student who has taken a specific test or you want a report on the test status for each 
student enrolled and you want the students listed alphabetically. 
 

1.  Select Reports (menu bar). 
 
2. Select Custom. 
 
 The Report Options screen displays. 
 
3.  Make the needed selections to customize your report. 
 
4. Select Print Report. 
 
 Print Preview screen displays. 
 
5.  Select printer icon in tool bar. 
 
6.  Select Print Range.  (The default is all pages.) 
 
7.  Input number of copies. (The default is 1.) 
8. Select OK. 

 
Important Note:  Depending upon the number of students you have enrolled, it may take 
several minutes (possibly hours) to generate the report before it displays on the Print Preview 
screen.  The more you filter and limit the report, the faster the report will be generated. 
 
 
40. REPORT OPTIONS 
 
The Report Options screen allows you to make selections that determine what the report will 
contain and look like.  Once these selections are made, the report output will display on the 
screen during Print Preview with the option of printing a hard copy. 
 
The following Report Restrictions are offered: 
 

• Specialty (All Specialties is the default.) 
• Training Area (All Training Areas is the default.) 

 
The Specialty and Training areas can be changed to meet your specific need(s) by making a 
selection from the drop-down menu available for each of these options. 
 
To specify the organization of the report output, you: 
 

• Select Organize Report.  
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The Report Organization determines how the student test data is arranged in the report.  The 
following six options are available for organizing your report: 
 
(1) Specialty 

Student (alphabetic) 
Training Area 
Test (by number or by date) 

 
(2) Student (alphabetic)  
 Specialty 

Training Area 
Test (by number or by date)  

 
(3) Specialty 

Training Area 
Test (by number)  
Student (alphabetically, date, or score)  

 
(4) Test (by number)  

Specialty 
Training Area 
Student (alphabetically, date, or score)  

 
(5) Test (by number)  

Student (alphabetically, date, or score)  
 

(6) Student (alphabetic)  
Test (by number or by date)  

 
The default is option number 1.  The Student or Test options, when available, are made by 
clicking on the associated option buttons in the Order Students and Order Tests dialog boxes at 
the bottom of the Report Organization screen. 
 
To specify which fields you wish to appear on the report, you: 
 

• Select Field Options.  
 
All the fields displayed on the Student Record are selected as defaults in the Field Options 
dialog box.  These include: 
 

• Social Security Number 
• Lock Status (Lock or Unlock) 
• Test Title 
• Test Status (Needed, Passed, and Failed) 
• Test Score 
• Date Test Last Taken 
• Number of Attempts at Test 

If you do not want a field included on the report, you deselect it by clicking on the check box. 
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Besides these six fields there is also a Social Security Number check box.  Select this check 
box if you want the students' Social Security Numbers displayed on the report.  
 
To filter and limit the tests displayed on the report, select one or more of the following options: 
 

• A single test 
 
• All tests that have been taken: 

- With a score between two percentages 
- With a specific number of attempts or more 

               -     Between two specific dates 
 

• Only tests that have been:  
- Passed 
- Failed 

 
• Only tests that are:  

- Unlocked 
- Locked 

 
41. HOW TO DOWNLOAD STATISTICAL DATA 
 
To download Statistical Data: 
 

1.  Open the Statistical Data Utilities. 
 
2.  Highlight the type of data (DoD Wide Data) you want to download. 
 
3. Select Download Data. 
 
 The “Copy Statistical Data To” screen displays. 
 
4.  Select the drive from the Drives drop-down list box. 
 
5.  Select the Directory. 
 
6.  Accept the default in the File Name test box as each file is assigned a unique name so 

the CerTest System will not allow you to download the file under any other name. 
 
7.  Select OK. 
 
8. Click on OK in the Download Complete! Information box when it displays. 
 
 You are then returned to the Statistical Data Utilities screen. 

 
42. HOW TO BACK UP THE CERTEST SYSTEM 
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Backing up the CerTest system ensures having a copy of CerTest with all tests and student 
records in the event that your computer crashes or that your network or hard drive becomes 
corrupted.  The system should be backed up at least once a week, more often if there are 
frequent changes in tests or student records. 
 

1.  Select Backup CerTest System from the File menu. 
 
2. Select the type of CerTest Backup you wish to make: 

 
• Site Specific Backup - This is the recommended backup type.  This option makes a 

backup of all student data, current statistical data, managers, and site-specific 
tests and graphics. 

 
• Site Specific Backup - No Tests - Use this option when there are site specific tests 

in the CerTest system and they have already been backed-up (copied) to diskette. 
 

1.  On the Backup CerTest System To screen: 
 

Select: 
 

• The target drive from the Drives drop-down list box  
• The Directory 

 
Note:  You may not change the file name of the backup file: 
 

• Site Specific Backups must be named CTBACKUP.001 
 

4.  Select OK. 
 
5.  If necessary, respond to any information boxes that appear. 
 
6. Select OK in the Backup Complete box. 

 
Additional Information:   
 
To restore from the backup diskettes you’ve created, select Restore CerTest System. 
In addition to the backup file, CerTest creates a text file that contains the date of the backup, the 
name of the Site and Station from which the backup was made, and the CerTest version 
number.  For Site Specific Backups, this file is named CTBACKUP.TXT. 
 
The Backup CerTest option does NOT backup archived statistical data. 
 
Helpful Hints: 
 

• If you are backing up the system onto disks, be sure to have several high-density 
disks ready to store the backup files. 
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• If you are running CerTest on a network, you may not need to use the Backup 
CerTest option.  Check with your network administrator about how your network is 
backed up.  Networks often have a tape backup system.  If your network is 
frequently backed up, you should not need to use the Backup CerTest option. 

 
43. HOW TO RESTORE THE CERTEST SYSTEM 
 
In the event that your computer crashes or that your network or hard drive becomes corrupted, 
you may need to reinstall the CerTest system records from a backup copy made using the 
Backup CerTest function. 
 
Note:  Any student activity that takes place after the backup copy was made will be lost if the 
system is restored. 
To restore the CerTest system from a backup made using the Site Specific Backup option or the 
Site Specific Backup - No Tests option:  
 

1.  Reinstall CerTest using the original installation CD (or disks). 
 
2.  Reinstall any CerTest update diskettes that you have received since the original 

installation CD.  Be sure to install them in the order they were received (check the 
dates and/or version numbers) 

 
3.  Start CerTest. 
 
4.  If the backup was made using the Site Specific Backup - No Tests option and there 

were site specific tests copied to diskette, copy these tests back into CerTest from 
diskette using the Copy From Diskette option. 

 
5.  Select Restore CerTest System from the File menu. 
 
6. On the Restore CerTest System From screen: 

 
Select: 
 

• The drive that contains the first backup diskette from the Drives drop-down list box 
• The Directory 
 
7. Select OK. 
 
8.  If necessary, respond to any Information boxes that appear.  The restore process may 

take several minutes or longer. 
 
9.  Select OK in the Restore Complete box. 

 
44. HOW TO COMPACT A DATABASE 
 
When you delete a student or a test from CerTest, the Database does not get any smaller.  A 
"hole" remains in the database where the student or test used to be. 
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If you have deleted many students, due to PCS, retiring, retraining, etc, you may wish to remove 
these holes by compacting the database.  This makes the Database smaller so that it takes up 
less space on your Hard Drive. 
 
Warning:  Always use Backup CerTest System before using Compact.  If an error occurs while 
compacting, your CerTest system may no longer be usable and you will have to use Restore 
CerTest System to restore from your most recent Backup. 

 
1. Select Compact Database (File pull-down menu.) 
 
 A message box appears giving the size of the CerTest database. 
 
2. Select OK 

 
Additional Information:  If you have not deleted many students or tests, Compact will not 
significantly reduce the size of the database. 
 
Note:  If you are running on a network, you must be the only user logged on to CerTest in 
order to use the Compact Database option. 
 
45. HOW TO REPAIR A DATABASE 
 
If there is a power failure or the computer is turned off while CerTest is writing data to the 
Database, the database may become corrupted.  If this happens, the CerTest system will 
behave strangely and frequent errors will occur.  Using Repair Database may fix this kind of a 
problem.  Sometimes the database may be so corrupted as to render it unrecoverable.  In this 
case you must use Restore CerTest System to restore from a previous Backup. 
 
Warning:  Always use Backup CerTest System before using Repair Database.  If an error 
occurs while repairing, your CerTest system may no longer be usable and you will have to use 
Restore CerTest System to restore from your most recent Backup. 
 
To repair the CerTest database: 
 
Select Repair Database (File pull-down menu.) 
 
Note:  If you are running on a network, you must be the only user logged on to CerTest in order 
to use the Repair Database option. 
 
46. CHALLENGING QUESTIONS 
 
What is a Question Challenge? 
 
While taking a test, a student may find a question that he/she believes to be erroneous or 
invalid for some reason (i.e., typo, spelling mistake, missing graphic, ambiguous question, etc.). 
 
Challenging Questions: 
 

1. Click the hand icon on the toolbar, or by select “Challenge This Question” from 
the Help menu. 
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2. Type a short but clear description of the error. 

 
NOTE: “This is a bad question” is not good rationale. 
 
You may also view, print, download, or delete some or all of these Question Challenges. 
 
View Question Challenges: 
 

1. Select File (menu bar). 
 

2. Select Print/Download Question Challenges.  The Print/Download Question 
Challenges window appears. 

 
NOTE: You may restrict the Question Challenges that you print, download or delete by selecting 

a date range and/or test number range.  If you do not select a date range or test number 
range, all Question Challenges in the Question Challenge database will be printed, 
downloaded, or deleted. 

 
Printing Question Challenges: 
 

1. Select Print/Download Question Challenges from the File Menu. 
2. Enter a date range and/or test number range to restrict the number of challenges 

you print. 
 

3. Click the Print button. 
 

   4.         Click the printer icon button to send the challenges to the printer; or, use the 
other buttons on the toolbar to browse the challenges on screen. 

 
Downloading Question Challenges to Disk: 
 

1. Select Print/Download Question Challenges from the File Menu. 
 

   2.        Enter a date range and/or test number range to restrict the number of challenges 
you download to the text file. 

 
3. Click the Download to Disk button. 

 
   4.         Select a name for the text file and a path to where you would like it to be saved, 
then click OK. 

 
NOTE:  The default file name is CHALLENG.TXT.  If the file already exists, you will be asked if 
you would like to append the Question Challenges to the end of the existing file. 
 
Deleting Question Challenges From the Database: 
 
Once you have printed and/or downloaded the Question Challenges and reported the valid ones 
to the CerTest point of contact specified in your Procedural Guide, you may wish to remove 
them from the database. 
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1. Select Print/Download Question Challenges from the File Menu. 
 
2. Enter a date range and/or test number range to restrict the number of challenges you 

delete. 
 
3. Click the Delete button. 
  

You will be prompted to confirm that you wish to permanently delete the challenges from 
the database. 

 
4. Click Yes. 
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